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Goals

1. Define three terms

 Dbraille ASCII
 Draille font
 smart quotes

2. Explain the difference between “dressing” text in a braille font
and print-to-braille transcription

3. Describe a new method for opening a BRF
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ASCII
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“braille ASCII” (or “ASCII braille”),
Examples

& &
f
6 &

(dots 123406)
(dots 124)
(dots 235)
(dot 6)
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ASCIl and QWERTY Keyboard
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File Edit Mavigate View Settings Emphasis Styles Insert Math Help

E@;#i ‘DC' LA
Braille ASCllat | B I U S M 7 [Ea}l” P IEIEISS

Work in S

Body Text This example is amazing!

BrailleBlaster
“dressed” In a
braille font

Print Page: . | Braille Page: | Line: 10. | Cell: 1. | Style: Body Text. |
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Braille ASCII
at Wo rk in Body Text This example is amazing!
BrailleBlaster

Print Page: . | Braille Page: | Line: 10, | Cell: 1. | Style: Body Text. |
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Braille
ASCII at
Work In

email

AMERICAN

PRINTING
HOUSE

Input on braille for Friday - Message (HTML)

)
W

Message Insert Options Format Text Review Help

Bk e A
B

Paste B I U £+ A . 7= 3= | Address Check | Attach
- ¥ - = Book Mames | File~

Clipboard u Basic Text = MNames

T @, org
coworker@work.org

Input on braille for Friday

Hello, Coworker!

Tell me what you want to do

@ ,;_; M ':__d) E/ Fl P Follow Up ~ @

= High Importanc _ - .
Link Signature Assign < L - Dictate Viva View

- - Palicy ~ -/ Low Importance nsights Templates

Include Tags (] Sensitivity Add-in | My Templates

Will you please let me know if the following braille transcription looks right to you?

/2 of nothing is still nothing.
#a/b ( no?+ is / no?+4

Cheers!
Kyle DeJute
(she/her/hers)
Braille Trainer, Braille Improvement Department
AMERICAN CPACC and Certified Braille Transcriber
:g:.anIs':'? kdejute{@aph.org
1839 Frankfort Avenue + Louisville, KY 40206
aph.org * info@aph.org

Our mission is to empower people who are blind or visually impaired by providing accessible and innovative products, maferials, and services for lifelong success.
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Braille
ASCII| at

Work In

email
“dressed”
in font APH
Braille
Shadows

AMERICAN
PRINTING
HOUSE

Input on braille for Friday - Message (HTML)

Message nsert Options Format Text

EPHBrmille ~| 12 -~ A" A

3 e T . A ck Attach Link Signature
- B I U \ ; ; = Attach Li gnaty
=1 =

High Importance
e : 1 =
File ~ = = elicy 4 Low Importance

Include Tags

Hello, Coworker!

Will you please let me know if the following braille transcription looks right to you?

/2 of nothing is still nothing.

Cheers!
Kyle DedJute

(she/her'hers)
Braille Trainer, Braille Improvement Department
AMERICAN CPA.CC and Certified Braille Transcriber
PRINTING kdejute@aph.org
1839 Frankfort Avenue + Louisville, KY 40206
aph.org * info@aph.org

QOur mission is to empower people who are biind or visually impaired by providing accessible and innovative products, matenals, and services for ifelong success
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b

BRAILLE FONTS




What does a bralille
font do?

A braille font “dresses” ASCII
characters so that they look like
their corresponding bralille cell
configurations.

®

AMERICAN
PRINTING
HOUSE

%
5
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[Simulated] Braille Font Applied to ASCII braille
Braille is literacy!

v B B 8- .- 9 99 ' . *® -
++ B+ 80 @ .- .- o I- o9 20 8 00
@ +cr B B o @ @+ s+ B @ s+ s+ B0 8-

 Translated and shown in ASCII bralille:
»> brlis litfjacy6

 Translated and then dressed in braille font:

P ERTR IR B HCHE I R L Rt X
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APH Braille Shadows Font

« font designed at APH

 available for free from the Building on Patterns website

o in Prekindergarten page, with TEACHER RESOURCES,
under the heading Parent Letters
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https://aphbop.org/pre-k/resources.html

A Poll! #1

Poll
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@ PRINTING How Braille Works Electronically

HOUSE




Poll #1
Which of the following shows braille ASCII?

A. My friend can swim.

B. ,my fr c swim4
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ASCIl BRAILLE, LIMITATIONS




Many Print Symbols are Not Part of the
Braille ASCII Set
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Quotation Marks and ASCII

& 2 (dots 12346) " i (dot5)
f 3 (dots 124) ' i (dot3)
6 # (dots 235) " no correspondence
. i (dot6) ~ nhothing
nope

not a single cell
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b

WHY WOULD | NEED BRAILLE
TRANSLATION SOFTWARE, IF |
HAVE A BRAILLE FONT?




Braille Translation is More Than Just a Button Push

for example:
Braille is literacy!

 Just dressed in braille font:

PR LR I FRL TR L LI HET

 Translated and then dressed in braille font:

PARTR IR B HECHE I LR Rt X
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Braille TRANSCRIPTION
iIs More Than Just Braille
TRANSLATION

Bralille transcription prepares text
with not only the translation but
also with formatting information.

How Braille Works Electronically




b

BRAILLE TRANSCRIPTION
SOFTWARE




A Poll! #2

Poll
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Poll #2

What braille transcription software do you use most often?
A. Braille2000

B. BrailleBlaster

C. Duxbury Braille Translator
D. Other
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How Does Software Do Braille Translation?

« Each word gets processed through a series of decisions

0 2)
Q [z
d ...

* Decisions start with unique possibilities and proceed
toward letter-for-letter translation

* Note: Multiple groups maintain braille translation tables
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How Does Braille Transcription Happen?

* beyond braille translation
* elements arranged based on file markup

* human touch makes possible
braille that is widely and deeply accurate
v’ contextually logical formatting, translation
v herding cats
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OPENING BRFS




BRF — Braille Ready File

* No codes or styles

 Hard spaces, line
breaks, page breaks,
ASCII characters

 QOften for embosser

» Easily readable by
multiple software
programs, including text
editors
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Using Various Programs to Open a BRF

Duxbury
Braille2000
Braille Zephyr
BrailleBlaster
. Web browser
Notepad

I N
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A Poll! #3

Poll
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Poll #3

How can smart quotes interfere with applying a braille font
to ASCII?

A. Smart quotes keep changing; they are not static

B. Directional quotes do not correspond to any bralille
cell configuration

C. There is no such thing as a braille quotation mark
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SCREEN READERS




How Do Screen Readers Create Braille?

* via bralille displays
o and that means drivers
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Challenges of Using Screen Readers with
Braille

« Support between refreshable braille display
and screen reader

* QOctopus syndrome
« Bajillion hot keys available
 and more
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Is a Screen Reader Enough?

Even though screen readers are important tools for access,
they do not provide literacy experience.
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EMAIL SIGNATURES




How to Create Your
Accessible Braille
Email Signature

1.

aswbN

o

Six-key your name in an Exercise box within
one of APH Tech’s bralille tutorials

« Nemeth Tutorial, UEB Math Tutorial
Copy/paste your name into a word processor
Apply a simulated bralille font to your name
Adjust the size of your name

Take a picture of that part of your screen
« Win + Shift + S in Windows 10
« Shift, Command, and 4 for Mac

Paste the picture into your email signature

. Add alt text to the picture (e.g., simulated

braille of Jane Doe)
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https://nemeth.aphtech.org/
https://uebmath.aphtech.org/
https://www.minitool.com/news/win-shift-s.html
https://support.apple.com/kb/index?page=search&q=screenshot%20on%20mac&requestid=&product=&currentPage=1&locale=en_US&includeArchived=false&doctype=&supportAnswerIndex=1

b

REFRESHABLE BRAILLE
DISPLAYS




“Nuts and bolts” of
refreshable braille displays

* Each cell is a multi-part unit.

* Piezoelectric braille cells are
the most popular cells in use
today. Though, there are
more designs.

 Some cell designs require
power both to push a pin up
and to keep it up.
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Struggles with Refreshable Braille Displays

* Print text displayed without transcription
* Rigid BRF

» Use of ASCII braille

* No formatting

* Linear user interface
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Benefits of Refreshable Braille Displays

2
3 ¥
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3 4 o
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 Digital buttons for typing
» Consistent quality of dots
* Oneline atatime

 Audio reinforcement via
screen readers and TTS
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A Poll! #4

Poll
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Poll #4

What does a “driver” do?
A. Drives up the efficiency of hardware
B. Takes control of all the technology in your life and

keeps you a prisoner of the machines
C. Helps pieces of hardware communicate
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eBRF

exciting New Horizons!
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What is an eBRF?

1

; -
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Benefits of eBRF
* Navigation!
* Dynamic content!




Status of eBRF, March 2022

« 2.0 draft has gone to international partners for feedback

* Once draft is complete, will complete first standard (for
BANA rules)

« Then we can make the first eBRF
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Join us in March for

UEB Math/Science: Frozen Juice
Concentrate

Mar 28" (Monday)
12:00-1:30 ET

l
B Cvn: Dematneees EOTI o i
Py
d .: II-! @
i

AMERICAN

PRINTING
HOUSE FOR
THE BLIND

- FROZEN
CONCENTRAY

il
CCCCC
cader 100% Daily Value of Vitamin C p




Summary

 Define three terms
1. braille ASCI|
2. braille font

3. smart quotes

» explain difference between “dressing” text in a braille font
and print-to-bralille transcription

* describe a new method for opening a BRF
« BONUS: create accessible, beautiful braille email signature
« BONUS: learn about eBRFs
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BONUS MATERIAL

If we have time




Other Braille Files

« BRL
 PEF
- DXB
- ABT
« BBZ
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Smart Quotes

« “Smart” quotes are directional, not "straight.”

* Directional quotes do not correspond to any braille cell
configuration.

S
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How to Turn Off Smart Quotes

* in Microsoft Word & PowerPoint

* File > Options > Proofing > AutoCorrect Options >
AutoFormat > Replace straight quotes with smart quotes

* in Google Docs & Google Slides
* Tools > Preferences > Use smart quotes

Or

« “Undo” (Ctrl+2z) right after the autoformatting takes place
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https://support.microsoft.com/en-us/office/smart-quotes-in-word-702fc92e-b723-4e3d-b2cc-71dedaf2f343
https://www.solveyourtech.com/turn-off-smart-quotes-google-docs/

Brains of Refreshable Braille Displays

 How do they know what
dots to raise?

o ASCII to braille cell
correspondence,

: | 0@ o e
same as simulated
braille fonts =l -
+ What file types can they lsAN |
open? O
« toread? g ;e
* to edit? - cige
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Various Kinds and Sizes of Refreshable Braille
Displays
 Notetaker

o suite of apps (including braille translation)
o browser and email client

* Hybrid
o basic apps (including braille translation)
o local functionality

* Terminal Only
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Six-key entry on a QWERTY keyboard

Can | six-key on my keyboard”?

* Information from UEB Online:
https://uebonline.org/getting-started/using-your-keyboard/

» Keyboard check from APH Tech:
https://nemeth.aphtech.org/sixdot e LY LY ) Y e Y 3 6
;g_g;@gg@@@@m@

What is “n-key rollover?” ﬂjjzgq.n@ﬁ
. 7@@ !L" ..W[
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https://uebonline.org/getting-started/using-your-keyboard/
https://nemeth.aphtech.org/sixdot
https://en.wikipedia.org/wiki/Rollover_(keyboard)

In-depth exploration of
Wikipedia’s table of braille ASCII values

Braille ASCII values |edit]

The following table shows the arrangement of characters, with
the hexadecimal value, corresponding ASCI| character, binary
notation matching the standard dot orderd?, Braille Unicode

glyph, and general meaning (the actual meaning may change

depending on CGI‘IIE}(t].[g:HG]
. . Unicode .
ASCIl | ASCIl | Braille Braille . Braille
Braille .
hex | glyph dots | glyph meaning
glyph
20 | (space) | 000000 (space)
21 ! 011101 . :: the
22 ) 000010 . : {contraction)
. (number
23 = 001111 . ' _
o prefix)

AMERICAN . .
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https://en.wikipedia.org/wiki/Braille_ASCII

Overarching
Goal

share (and really explain) concepts to help yall
describe struggles and imagine solutions related to
sharing and accessing braille electronically
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